Welcome to Open Transport

This chapter introduces Open Transport. You can save time later if you take a
few minutes now to learn about Open Transport and what you use it for.

What is Open Transport?

Open Transport is the modern, industry-standard networking and
communications software for the Mac OS. With Open Transport software
installed on your computer, you can

= Use more than one networking system at once (for example, AppleTalk to
communicate with network printers and TCP/IP to connect to the Internet)

= Save and modify different networking configurations
= Switch among networking configurations quickly and easily

Open Transport includes the AppleTalk and TCP/IP control panels. These
replace the Network and MacTCP control panels used in previous versions of
the Mac OS. You can use Open Transport on any Mac OS computer that uses
a PowerPC processor, or a 68030 or 68040 processor. Open Transport is
required on any Mac OS computer that uses the PCI bus.


Instructions

To continue reading, use the scrollbar on the right. To go to a new section, click its title on the left.
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About this book

To use pen Tanspot, you first install he oftware ontd your Mac G5
computer The Open Tanspot Installer paces the AppleTalk and TCP/IP
control panels into your Gontrol Panels folder You wse he AppleTalk control
pandl to set up gur mwnnedion  an AppleTalk network (that i a retwork
using the AppleTalk protocal). You wse he TCP/IP control panel to set up
your @mnnredion  the Intemet, and © a TCP/IP retwork. TCP/IP stands br
Transmision Gontrol Protocol/l ntemet Potocoal, an industry-standad g/stem
for conredions letween omputers bdifferent tys

This book & for Open Tanspot users ad for admnistrabrs d networks that
indude mmputerstiat tse pen Tanspot. Herés what yodll find in the
remaning chapters:

» Chapter 2 pwides instiuctions br installing the Open Tanspot software
on your @mputer If you recéved Qpen Tanspot with a Mac (5
computey the ftware ha been nstalled ér you, and you @n Kip
Chapter 2

» Chapter 3 decribes hav to use he AppleTalk control panel to set up ad
control your mnredion © an AppleTalk network.

= Chapter 4 decribes hav to use he TCP/IP control panel to set up ad
control your mnnedion  a retwork that wses TCP/IR qauch as an Ethemet
network or he Intemet.

» Chapter 5 pvides troudeshooting suggestions

What you need to know before you begin

Chapter 1

This book asumes that you hare besic Madntosh &ills You shold knav
how to

= Use he nouse and keyboad

= choose ommands flom menws

= open Dlders ad appication pograns
= save daunments



If you need b lean more abouthese lasic tasks, consllt the leaning
materals that @ame with your omputer

You mg need addibnal informaion abouthe retwork o which your
computer $ mnneded, or abouthe sevice tirough which your @mputer $
conneded b the Intemet. T get this informaion, you ma need 6 contad
your retwork admnistrabr or your Intemet sevice povider See Chapters 3
and 4 pbr detais abouthe informaion you reed ad where b look for it.

Other sources of information

In additon b this book you @an take adiantage d the onscreennistruction
built i nto Open Tanspot—Balloon Hép and (if you are sing s/stem
software \ergon 753 or later) Apple Guide instrudtions

When Balloon Hép for Open Tanspot is tumed on, yu @n get informaion
about ay item on he screenimply by panting to the item wih the nouse

You @n get step-lg-step nstructions br using the Open Tanspot control
panels with Madntosh Guide availalde in the Quide (@) menu when he
Finder B the adive piogram

There mg be late-breakig news about @en Tanspot that s not nduded
in this book Open te Read Me ile that ame with Open Tanspot to find
addiional informaion. This file also indudes informaion on he new
featurs d Open Tanspot.

Welcome to Open Transport 1.1
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Installing Open Transport on Your Computer

Before you @n set up @en Tanspot and begin using it, you need b install
the oftware

IMPORTANT If you recéved Cpen Tanspot padkaged with a Mac (5
computey the ftware ha alreagl been nstalled on gur omputer XKip this
chapter ad ontinue with Chapter 3

What do you need to use Open Transport?

Your mmputer mst hae the following featurs © use (Qpen Tanspot:
= a PowerPC central mcessng unit (CRJ) or a 6830 or 6840 CRJ
= at leat 8 megabytes (MB) o random-acess memory (RAM)

= System sftware \erson 7., 711, 712, or 753 (g/stem sftware erson 753
or later B reommended)



Installing Open Transport the easy way

To install Qpen Tanspot on your had disk, you wse he Installer pogram on
the first instalation dik induded n the Open Tanspot padkage This
sedion describes the basic Open Tanspot instalbton (alled “Easy Install”)
that gives you the ftware you reed n most @ses For instiuctions on
installing spedfic pottions d Open Tanspot software see e rext sedion,
“Doing a Cstom Instalaton”

1 Turnon your computer and wait until the Mac OS desktop appears.
2 Insert the first Open Transport installation disk.
3 Double-click the Installer icon.

A screen apgars velcoming you b the Open Tanspot Installer

Communications Architecture

This Iretaller installs everything reeded
touse the Open Transport
Communicatiors Architectire

Open Transport

Note: If you are nstalling over an dder vergon d Open Tanspot, you mgy
see nessages during the installtion aking if you want to install rewer
versons d files that alreagl exist on yur had disk. Make sure you alvays
choose o install be new versons ¢ ead file.

6 E Chapter 2
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Click Continue.

After a Bw moments this windov appears:

=————— 0pen Transport Installation E=iF=F"=—7—=]
| Easy Install -

Click the Install button to install:

* AppleTalk 1.1 support for all Macintoshes

« TCP/IP 1.1 support for all Macintoshes

* Classic networking compatibility for all Macintoshes

fient fisk
[ esen )

Internal HL

[

Make sure you seem the Destinaion Disk bax the nane d the disk on which
you want o install Qpen Tanspot. You @n install Qoen Tanspot on awy
had disk that h& the @mrred verson d system sftware nstalled. If ypu
dorit see lhe @rred nang, dick Switch Disk untl you seehie nane d the
disk you want.

Click Install.

=——— Open Transport Installation =Fr——"—1
[ Easy Install ]

Click the Install button to install:

* AppleTalk 1.1 support for all Macintoshes

« TCP/IP 1.1 support for all Macintoshes

* Classic networking compatibility for all Macintoshes

Eiwnt ek
EE [

If any appication piograns are unning, the Installer pompts yu o quit
those pograns.

TR
Internal HL

A statis screen shes you the piogress d the instalbtion. When te
instalaton is mmpdete a nmessage tdls you .

Installing Open Transport on Your Computer

ecccoe
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Click Restart to exit from the Installer program and restart the computer.

You hae finished installing Open Tanspot. To set up ad wse he AppleTalk
control panel, tum to Chapter 3To set up ad wse he TCP/IP control pand,
turn to Chapter 4If you dort know which control panel to use conault your
network admnistrabr or Intemet sevice povider

Doing a custom installation

Chapter 2

To install sgedfic pats d Open Tanspot, follow these steps:
Turn on your computer and wait until the Mac OS desktop appears.

Insert the first Open Transport installation disk.

Double-click the Installer icon.

A screen apgars velcoming you b the Open Tanspot Installer
Click Continue.

After a Bw moments this windowv appears:

Open Transport Installation ==———-——-1|

[ Easy Install -]

Click the Install button to install:

* fAippleTalk 1.1 support for all Macintoshes

« TCP/IP 1.1 support for all Macintoshes

* Classic networking compatibility for all Macintoshes

fisot sk
Internal Hx I Install I

[




5  Choose Custom Install from the pop-up menu.

Open Transport Installation E==—=——=-|

+Easy Install

Custom Install

Custom Remove ™ | i
to install:

» AppleTalk 1.1 support for all Macintoshes
« TCP/IP 1.1 support for all Macintoshes
* Classic networking compatibility for all Macintoshes

Eiwnt sk

Internal HI» I Install I

[

Make sure you seen the Destinaion Disk bax the nane d the disk on which
you want to install Qoen Tanspot. You @n install Gpen Tanspot on ay
had disk that ha the @rred verson d system sftware nstalled. If pu
dorit see lhe @mrred nang, dick Swvitch Disk untl you seehie nane d the
disk you want.

6 Inthe window that appears, choose the items you want to install.

=—— 0Open Transport Installation E&"ce=FF°"——P5
[ Custom Install  + | [ Hein |
. Check features to be installed _
For each item you L] Open Transport (68K Only) @ |
want to install, [ Open Transport @
H H [+ [ AppleTalk support for Open Transport ]
click its box to, pgt I [ TCP/1IP support for Open Transport [H]
an Xin it @
[H] . .
@ Click the letter ito
= see information
Drisk space available: 137,564k Selected size: zero K .
...... Destination Dick about each item.
Eiwnt ek
[

Installing Open Transport on Your Computer

ecccoe
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Chapter 2

Click Install.

If any appication piograns are unning, the Installer pompts yu b qut
those pogramns.

A stats screen shws you the progress d the instalaton. When he
instalaton is mmpete a nmessage tdls you .

Click Restart to exit from the Installer program and restart the computer.

You hae finished installing Open Tanspot. To set up ad wse he AppleTalk
control panel, tum to Chapter 3To set up ad wse he TCP/IP control pand,
turn to Chapter 4lf youre not sire which control panel to use consilt your
network admnistrabr or Intemet sevice povider



Setting Up and Using the
AppleTalk Control Panel

You wse he AppleTalk control pandl when your omputer $ @nneded b a
network that wses the AppleTalk protocol. A network using the AppleTalk
protocol may use LocalTalk, Ethemet, or oher types d calling. If you dort
know whether your retwork uses the AppleTalk protocol, contad your
network admnistraor.

Read bhe instructions n this chapter ® acomgish te following tasks with
the AppleTalk control panel:
s Spedfy the pot through which your mmputer $ mnneded b the network

= choose e retwork zore in which your omputer appars (if your network
allows tis)

= Use onfiguraions b change all your setitngs at once

= see ad we Bsic, Advanced, ad Administraive setitngs
= get informaion about gur AppleTalk setup

= turn AppleTalk on and df

11
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Getting help in the AppleTalk control panel

When te AppleTalk control panel is open, you @n get wo types d onscreen
help: Balloon Hdp and Madntosh GQuide Turn on Balloon Hép to find out
more abouthe itens in the @ontrol panel windovs Use Madntosh Giide for
step-ly-step nstuctions about sing the mntrol panel. (Madntosh Quide s
availalde onl if you hare g/stem sftware erson 753 or katet) Balloon Hép
and Madntosh Guide are wailabe in the Quide (@) menu (Madntosh Giide
is ony availabe in the menu when he Finder B the adive program) In
addiion, you @n open Madntosh Quide ty dicking the Quide (@) buton in
the lowerleft corner d ead control panel window.

Setting up your AppleTalk network connection

Chapter 3

To set up gur AppleTalk network conredion, you must sgedfy the pot you
use b conned your cmputer o the retwork. If your retwork ha nmore han
one zore, you @n dhoose e zore in which your omputer § located. The
zore you choose $ the zore that s aubmaically sdected in the Chooser r
examge, when you sdedt a retwork printer) and it is the zore in which other
network users an find your omputer if ypu tum on fle sharng.

To set up gur retwork conredion, follow these steps:

Choose Control Panels from the Apple (@) menu.

About This Macintosh...

AppleCD Audio Player
£ Automated Tasks
Calculator

S Chooser

5] Control Panels

42 Find File

™ Jigsaw Puzzle
Key Caps

Note Pad

Recent Applications
[&] Recent Documents
Recent Servers
Scrapbook

G Stickies

B » Shut Down

The Gontrol Panels windowv opens



Double-click the AppleTalk icon to open

it.

The AppleTalk control panel opens

V7= AppleTalk
Connect wia: | Ethernet > |—

Setup
’7 Current zone Marketing zone -

@

| If you don't see a pop-up menu here, this setting has
been locked or your computer has only one port. You
use the Administration user mode to lock and unlock
settings.

Use the “Connect via” pop-up menu (if available) to choose the port by which your

computer is connected to the network.

ElE——— AppleTalk

Connect via: LHRGEg
Muodern port
Printer part

Setup
’7 Current zone: | Marketing zone -

| With Open Transport, you can connect to an
AppleTalk network through the printer port, the modem
port, or any additional ports installed in your computer.
If you have more ports installed, they appear
automatically in this pop-up menu.

@

Use the Current Zone pop-up menu (if available) to choose the zone you want.

If you don't see a pop-up menu here, this setting has

S[[=———-= AppleTalk
Connect via: | Ethernet bl l
Setup Euilding 5
Easztern division
Data processing
Current zone :
Internet access

been locked or your network is not set up to allow you
to choose a different zone. Zones are set up by the

network administrator.

Setting Up and Using the AppleTalk Control Panel 13
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Working with AppleTalk configurations

Chapter 3

An “AppleTalk configuraior’ is a ©llection d setings you male in the
AppleTalk control panel. The group d setings curenty disdayed in the
control panel is te ative anfiguraion.

You @n save different goups @ setings (configuraions) and svitch anong
them & deired—for examge, if you wse yYour computer h more han ore
location.

= Make sure the AppleTalk control panel is open, and choose Configurations from the
File menu.

Close AL

Configurations...
Get Info #1

Quit #0

The Qonfiguraions whndow opens

=——— Configurations =—————
fictive configuration: Default The Default configuration appears the
_ first time you open the Configurations
& -
window.
You may see more configurations in
this list if your network administrator
has provided them.
S 123 €200
=
] [ cancel | [ Make Active ||

Choosing a configuration

If you seetie mnfiguraion you want in the list dick it, then dick Make
Active The onfiguraion window doses, and the onfiguraion you dose
takes dfed.



Making a new configuration

You male a rew configuraion by stating with an existing ore and nodifying
it. To create a ew configuraion, follow these steps:

In the configuration list, click to select the configuration you want to modify.

Click Duplicate.

In the window that appears, type a name for the new configuration, then click OK.
The new configuraion nane apgars n the list.

Click the new configuration name, then click Make Active.

The nfiguraions wndowv doses

Make any changes you want to the control panel settings.

Click the close box to close the control panel (or choose Quit from the File menu).

A box appears &ing if you want to sve the dhanges you maded the
configuraion.

Click Save.

The new configuraion is sved with the changes you madeThe rext time
you open he AppleTalk control panel, your new configuraion will sill be in
effed.

Saving a configuration as a file

You @n save (export) a onfiguraion & a fle separate bm the AppleTalk
control panel. You @n use (impot) the file to aubmatcally duplicate he
control panel setings on aother mmputer ging Open Tanspot. To sve a
configuraion & a fle, follow these steps:

In the Configurations window, click to select the configuration you want to save as a file.
Click Export.

In the box that appears, type a name for the configuration file, and choose the folder or
disk where you want to save it.

Setting Up and Using the AppleTalk Control Panel

ecccoe
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Choosing Basic,

Chapter 3

Click Save.

Your configuraion is sved & a fle in the locaton you cdhose wih the nane
you spedfied.

Opening and using a saved configuration

You @an open and wse (impot) a onfiguraion file that ha been &ported
from the AppleTalk control panel. To open axd wse a onfiguraion file, foll ow
these steps:

In the Configurations window, click Import.

In the box that appears, click to select the configuration file you want to use.
Click Import.

The @nfiguraion is impoted into the Gonfiguraions window.
Click Make Active.

The setitngs spedfied in the impoted onfiguraion tale dfed immediatdy.

Advanced, or Administration settings

When you first open he AppleTalk control panel, you see oyl the basic
settings Basic setings piovide he mntrols you reed h most @ses. To see or
change oher setitngs, you must dhange the wser node flom Basic to
Advanced or Alministraion. Settings you male in Advanced ad
Administraton node stg in dfed if you change © Basic mode even tiough
you mg not ke alle to see lie setings.

IMPORTANT The Advanced ad Administratve nodes indude sefings that
can cauwse retwork problems if used impopety. If you are not@re hav to use
Advanced or Alministraion seftings, leave the setings undianged unil you
ched with your retwork admnistrabr.



In Basc mode the AppleTalk control panel looks like this:

E[[&=——— AppleTalk
Connect via: Ethernet V:I— .
In Basic mode, you can see and
Setup usually change the port and
Current zone: your ComputerS current zone.
@

In Advanced node the AppleTalk control panel looks like this:

EI=—— nppleTalk
Connect via: | Ethernet hd l

— Setup

Current zone: In Advanced mode, you can see and usually change
your computer's network address.

WARNING Do not do this unless you are sure your

Node: 2 address information is correct.
Metwork: I5303

AppleTalk address: D User defined

Metwork range:  Z5Z01 to 35304

4] Info Options...

Click Info for details Click Options to turn AppleTalk off
about your settings. or on again.

In Administraton node the AppleTalk control panel looks like this:

ECI==——— AppleTalk
Connent via: |_Ethernet 1 [#—}— In Administration mode, you can lock settings so they
- setup can't be changed. To lock a setting, click the lock

button. To unlock it, click again.
Burrent zone (o)

AppleTalk address: D Uzer defined @
Mode: 73

Network: 35303

Metwork range: 33301 to 35204

@ ]

For more informaion about @ng Administraton node see e next sedion,
“Using Administraton Mod¢’

Setting Up and Using the AppleTalk Control Panel 17
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Chapter 3

To dchange the wser node follow these steps:

With the AppleTalk control panel open, choose User Mode from the Edit menu.

_Edit [

ifnifn H
HEES i
fopy HE
Pauia i
HEES T it

User Mode... U

In the dialog box that appears, choose the mode you want, then click OK.

User Mode
Select user mode:
@ Basic
{» Advanced
r Administration Led Pagsard..,
7 (cancel | [ ok ]

If you cdhoose Alministraton node and it ha been poteded ty a pasword,
a bo appears ¢ enter he pasword.

The mah control panel window changes © rdlect the node yu dose



Using Administration mode

When youre in Administraton node you @an lock and unbck settngs, and
set a pssword limiting acess b Administraton node To set a pssword,
follow these steps:

With the AppleTalk control panel open, choose User Mode from the Edit menu.

In the window that appears, click the Administration button.

Click Set Password.

In the box that appears, type the password you want to use.

When you type the pasword, you see dotss] instead bthe letters gu type
Type the password again to make sure you typed it correctly, then click OK.

If you change the wser node b Basic or Advanced, yu must wse he
password to change the node ladk to Administraton.

Locking settings

To lock settngs, set he AppleTalk control panel to Administraton node then
click the lock icon rext to eat seting you want to lock. Click again to unlbck
a seting. If you change the wser node b Basic or Advanced, he setings you
lock cannot ke changed.

ECI=——— HAppleTalk
Connect via: [ Ethernet =] @——T0 lock a setting, click the lock button.

To unlock it, click again.

- Setup

Current zone : Marketing zone hal @

AppleTalk address: D User defined @
Mode: 73
MNetwork: ZT303
Metwork range: 33201 to 25204
@i

Setting Up and Using the AppleTalk Control Panel E 19
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Getting information about your settings

Chapter 3

For detailed mformaion abouthe AppleTalk addreses and oftware \ersons
currenty in dfed, do his:

m Choose Get Info from the File menu.

If the control panel is in Advanced or Alministraton mode you @n ako
click the Info buton.

The AppleTalk Info window opens You @n see mformaion in this windaw,
but you @nnot dange it.

AppleTalk Info

— Addresses: —

This Macintash: 352032 .
Hardware address: 5 00 07 54 AS B0 Depgndmg on your computer and your network, some

Router : 3520196 of this information may not appear.

— Yersions: e
Open T 1 . ,
ot You can check the versions of your computer’s
appleTalk driver: €01 networking software.

@

This Macintosh address

Your ommputels AppleTalk addres is a numler that unqudy identfies it on
the retwork. The numler © the Ieft of the dot 5 your mmputeis network
numker. The numtker o the right d the dot & the node numér. Unless you
choose ¢ set a spdfic AppleTalk addras (which is not reommended) your
computer booss an AppleTalk addres every ime it stats up This neans
that e numter you see myabe different if you shut dwn and restatt your
computer



Hardware address

The hadware addrss is a numier identfyi ng the pot you use b conned
your mmputer ¢ the network. Ethemet potts and many networking
expandon @ards hae hadware addrsses. Your momputels seral poits do not
have hadware addrsses.

Router address

A router 5 a deice (or a pogram unning on a rtwork device) hat dreds
informaion abng the nmost dficient or appopriate retwork pahs It is
conneded b a retwork at a pint between wo or nore goups & computers
and oter rework desices, and it contains a Ist identfyi ng the addreses o
the mmputersm eat group When a paket d informaion reabes the
router the muter diedks the addres d the mmputer he pa&et is being sent
to and direds it o the pat of the retwork contaning that addres

The AppleTalk Info windov shavs the retwork addres d the router
currenty being used ly your mmputer This addres ma not aivays be the
same kecauwse yur mmputels AppleTalk software onstantly looks for the
best router b use When onditons on lhe retwork change, the ftware my
choose a dierent puter

If no addres is availalde, it means hat your omputer ves unale o find a
router or your retwork does not hae any routers

Setting Up and Using the AppleTalk Control Panel
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Turning AppleTalk on and off

Chapter 3

When you are not sing an AppleTalk network, you an tum AppleTalk off to
save RAM in your mmputer When you reed 6 use AppleTalk again, you @n
turn it on To tum AppleTalk on and df, follow these steps:

Make sure the user mode is set to Advanced or Administration.

For instiuctions on banging the wser node see “Choadsyg Basic, Advanced,
or Administraton Settings’ ealfier in this dapter

Click Options.

In the window that appears, click to turn AppleTalk on (active) or off (inactive), then
click OK.

AppleTalk Dptions

Make AppleTalk:

@ Active

) Inactive

4] [cancel | [ ok |

AppleTalk becomes adive or nadive & ©on & you dick OK.



Setting Up and Using the TCP/IP Control Panel

You wse he TCP/IP mntrol panel when your mmputer $ onreded b a
network that tses TCP/IP standads TCP/IP (Transmision Gontrol

Protocol/l ntemet Potocol) is a stadad set & rules (or potocols) for making
conredions anong different tyges d computers TCP/IP piotocols an be
used wih many different tyms d network hadware induding LocalTalk,
Ethemet, and dialup Intemet cnnedions If you dort know whether your
network uses TCP/IR contad your retwork admnistraor.

Read bhe instructions n this chapter ® acompish te following tasks with
the TCP/IP mntrol panel:

spedfy your retwork connedion

enter yur IP addres and subret mak (or identfy the sever from which
they are aailade)

use onfiguraion files

see ad wse Basic, Advanced, or Alministraton setings
get information about pur TCP/IP setup

turn TCP/IP on ad df

understad the various setings in the TCP/IP control panel

23
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Getting help in the TCP/IP control panel

When he TCP/IP ontrol panel is ogen, yYou @n get wo types d onscreen
help: Balloon Hép and Madntosh GQuide Turn on Balloon Hép to find out
more abouthe itens in the @ntrol panel windon. Use Madntosh Guide for
step-ly-step nstuctions about sing the wntrol panel. (Madntosh GQuide s
availade only if you hare g/stem sftware erson 753 or katet) Balloon Hép
and Madntosh Guide are aailabe in the Quide (@) menu (Madntosh Giide
is ony availabe in the menu when he Finder B the adive program) In
addiion, you @n open Madntosh Quide ty dicking the Quide (@) buton in
the lowerleft corner d the @ntrol pand window.

Setting up your TCP/IP network connection

Chapter 4

To set up gur TCP/IP rnetwork connedion, you must spedfy the pot you wse
to conned your omputer ¢ the network. TCP/IP networks ako requre
informaion about pur mputeis retwork addres. You must enter lhat
informaion in the @mntrol panel, or spedfy a sever on which the informaiton
can be found.

You @n male it eaier o find retwork sewices by enterng addreses d name
sewvers and doman nanes you want to use Name severs vork like
aubmaic phore bools for locating network sexices and domai nanes are
like postal addsses for locating network sewices. This informaion ma also
be piovided ly a sever, if your retwork indudes a sever with this apalility.

Before you begin

To use a TP/IP network, your omputer mst hare an IP (Intemet Potocoal)
addres, and it dten mwst hae a sibret mak numkber. This informaion @n
be entered maually or obtaned aubmaically from ore d several types o
sewners Before you set up gur TCP/IP network connedion, obtan your IP
address and subret mak number from your Intemet sevice povider or
network admhistrabr. If these @n be obtaned aubmatcally from a sever,
find out vhether the sever is a ‘BootP “RARP’ “DHCP;” or “MaclP’
sewer.



“RARP’ stands br Reverse Aldress Resolution Ptocaol. A RARP sewver @an
provide he IP addres for your omputer (yu must poovide he rest
manually).

“BootP’ stands br Boot Potocol. A BootP sever an aubmatcally provide
all the TCP/IP setup mformaion you reed.

“DHCP” stands br Dynamic Host @nfiguraion Piotocol. A DHCP sever
can aubmaitcally provide all he TCP/IP setupmformaion you need.

“MaclP’ stands br Madntosh htemet Potocol. MacIPis boh a type o
sewver and a potocol for sendig Intemet-type pa&ets d informaion over
an AppleTalk network. A MaclP sewer @an provide he IP addres for your
computer

Setting up

To set up gur TCP/IP rnetwork connedion, follow these steps:
Choose Control Panels from the Apple (@) menu.

The Gontrol Panels windowv opens

Double-click the TCP/IP icon to open it.

TCF /P
The TCP/IP @mntrol panel opens
SeE——"——— T(PFIP "1 —"1———"+"w—TF
Connest via: [_AppleTalk (Maz ) | — | Ifyoudon'tsee all of the
[~ Setup settings shown here, some
Confiqure : Manually - l .
settings may have been
locked. You use the
P airess: | | Administration user mode to
lock and unlock settings.
Subnet mask: | |
Router address:
Search dornains :
Mame server addr.:
@
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Use the “Connect via” pop-up menu to choose the port by which your computer is
connected to the network.

Use the Configure pop-up menu to choose a configuration method.

If you are onneded wsing Ethemet, the pop-up renu boks like tis:

Configure :

H:;g Eeotb Server 1 You may see different items in this list if you have
Using RARF Server other kinds of networking software installed.

If you are onneded wng AppleTalk (MaclP), the pop-up renu boks
like tis:

[MUTERIITOR * Li=ing MacIF Manually
Uzing Mac|P server

Configuring TCP/IP manually for an Ethernet connection

You must configure TCP/IP manually if your sevice povider or retwork
admihistrabr gave you an IP addres (and posibly other informaion) b use

IMPORTANT Make sure your IP address is mrred. Entering an incorred
address @n cause pohlems on yur omputer ad on he retwork.

To configure TCP/IP manually for use wit an Ethemet pot, follow these
steps:

Type the IP address number for your computer in the IP Address box.

An IP addres is a set bfour numiers fom 0 b 25, separatedybdots (br
exampe, 111123222.213). It identfies your @mputer onlie retwork.

If you have a subnet mask number, type it in the “Subnet mask” box.

Some retworks are diided nto sedions @lled sibretworks, or sibrets A
subret mak is a set bnumbers sed h conjunction with an IP addres
identfy the subretwork your mmputer $ onreded b. Like an IP addrss, a
subret mak is a set bnumkbers fom 0 b 25, separatedybdots (br
examge, 128000). If you do not enter aubnet mak, Open Tanspot
provides a déaut value aubmatcally.



If you have a router address, type it in the “Router address” box.

A router addrss is the IP addres for a outer—a deice hat dreds
informaion abng the nost dficient or appopriate retwork pats It is
conreded b a retwork at a pmnt between wo or nore goups & computers
and oter rework devices, and it cntains a Ist identfyi ng the addreses o
the momputersi eat group When a paket d information reabes the
router the muter tiedks the addres on he pa&et and sends itd the pat of
the network contaning that addrss. If you doft enter aouter addrss, you
may not ke alle to acess your whae network.

You @n enter nore han ore outer addrss (press the Retum key after eab
address you enter)

If you have additional information, type it in the appropriate boxes.

EN=——————— TCP/IP
Connect via: AppleTalk (MaclF) - I
— Setup
Configure : Manually bl | Select Hosts File... 1 These buttOﬂS and bOXES
appear only if you choose the

Irnplicit Search Path: . .
Starting demain name Advanced or Administration

P Address: || | | user modes.

Subnet mazk: | | Ending domain narne :

Router address:

Additional
Search domains:

Narne server addr.:

D Cop)

Name server address

A name sever addres is the IP address d a hane sever (or doman nane
sewnver)—a omputer hat males availabe the network addres numiers br
computers ad oher retwork devices that you knav by nane For examge, if
you want to find a host amputer alled “severxyz.com,” a hane sever
could aubmaftcally matd that nane with an IP addres (he mmputetto-
computer addrss).

Setting Up and Using the TCP/IP Control Panel
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You @n type nore han ore nane sever addres in the nane sever addres
boax. Press Retum dter eab addres You @n list & may nane severs &
you want &s long as your list dcesrit total nore han 25 letters ad ymbds

Hosts file

The Sec Hosts He butbn apgars ony when tie TCP/IP control panel is
set b Advanced or Alministraton wser node For instructions on sethg the
user node see “Choasg Basic, Advanced, or Alministraton Setings’ later
in this dhapter

A Hosts fle is a Ist f DNS (Domain Naming System) reources. It is sbred
on your @mputeils had disk. You wse a Hostsile to ealy aacess retwork
informaion you wse frequeny. This is the same fundion piovided ly nane
sewers It is reommended hat you ulse nare severs raher than a Hostsife.

Implicit search domains

The imdicit seartt doman bokes apgar ony when he TCP/IP control panel
is set® Advanced or Alministraton wser node For instructions on seihg
the wser node see “Choadsg Basic, Advanced, or Alministraton Setings
later n this dhapter

TCP/IP can aubmaically seart for computers gu patially identfy (in a
networking appicaton program) ly “host nand—a nane repreening that
computer onlte network. To male the searh posible, you spedfy a nane
represening a bcal network doman (the “stating nan®’) and a nare
representng a higer doman containing the local doman (the “ending
nane’). TCP/IP uses the domain nanes you enterd searh for a \alid host
name when you identfy only patt of the nane

For more informaion about domai nanes and hav the searh process
works, see “Name Srvers Domain Names, and Domain Seardiing,” later n
this thapter



Additional search domains

TCP/IP can searh for computersm different domais tian yours You
spedfy the domais you want to searh in the Additional Sard Domans
box. Press the Retum key after eabh doman nane you type You @n list &
many searb domans & you want & long as your list daesrit total more han
2% letters ad ymbds

For more informaion about domai names and hawv the searh process
works, see “Name Srvers Doman Names, and Domain Searding,” later n
this thapter

Configuring TCP/IP for use with an Ethernet server

To configure TCP/IP using a BbotPsewner or a DHCRsewer, all you need b
do is dhoose he appopriate type d sewer from the Gonfigure pop-up ranu
The sever wually provides all he mnfiguraion informaion reeded i
TCP/IP

A RARPsewer povides ony the IP address for your computer If your
network uses sibrets and if you hae additonal TCP/IP configuraion
informaion b entey follow the instructions in the setion “Configuring
TCP/IP Manually for an Ethernet Gonnedion; ealier in this dhapter

Configuring TCP/IP manually for a MaclP connection

You must onfigure TCP/IP manually if you are onneded b the network
using AppleTalk and your sevice povider or retwork admiistrabr gave you
an |IP addres (and posibly other informaion) b use

To configure TCP/IP manually for use wih MaclP, follow these steps:
Type the IP address number for your computer in the IP Address box.

An IP address is a set bnumbers flom 0 b 25, separatedybdots (br
examge, 111123222.213). It identfies your mmputer onte retwork.

Setting Up and Using the TCP/IP Control Panel
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If you have a subnet mask number, type it in the “Subnet mask” box.

Some retworks are diided nto se¢ions @lled sibretworks, or sibrets A
subret mak is a set bnumbers sed h conunction with an IP addres
identfy the subretwork your mputer $ onneded b. Like an IP addrss, a
subret mak is a set bnumkbers fom 0 b 2%, separatedybdots (br
examge, 128000). If you do not enter aubnet mak, Open Tanspot
provides a déaut value aubmaitcally.

If you have a router address, type it in the “Router address” box.

A router addrss is the IP addres for a outer—a deice hat dreds
informaion abng the nost dficient or appopriate retwork pats It is
conreded b a retwork at a pint between wo or nore goups & computers
and oher retwork devices, and it contans a Ist identfyi ng the addreses d
the omputersim eat group When a paket d information reabes the
router the muter diecks the addres on he paket and sends itd the pat of
the retwork contaning that addrss. If you doft enter aouter addrss, you
may not ke alde to acess your whae network.

You @n enter nore han ore outer addrss (pres the Retum key dfter eab
address you enter)

If you have additional information, type it in the appropriate boxes.

Connect wia: [ AppleTalk (MaclF) -]
- Setup
Configure: Wzing MacIP Manually -] Gelect Hozts File... | These buttons and boxes
MaclP server zone:  Mking Dept Eone Irnplicit Search Fath: appear Only |f yOU ChOOSE the
Starting domain name Advanced or Administration
P Address: | | | user modes.
Ending dorain narne :
Router address:
Additional
Search dormnains :
MName zerver addr.:
@
| |
| |




Name server address

A nane sever addres is the IP address d a nane sever (or doman nane
seiver)—a @mputer hat males availabde the retwork addres numters br
computers ad oher retwork devices that you knaw by name For examge, if
you want to find a host eamputer alled ‘sewverxyz.com’ a nane sever
could aubmaitcally matd that nane with an IP addres (he mmputerto-
computer addrss).

You @n type nore han ore nane sever addrss in the nane sever addres
bax. Press Retum dter eab addres You @n list & may nane severs &
you want as long & your list daesrit total nore han 25 letters ad ymbds.

Hosts file

The Sect Hosts He butbn apgars ony when te TCP/IP control panel is
set b Advanced or Alministraton wser node For instrudions on seitg the
user node see “Choasig Basic, Advanced, or Aiministraton Setiings’ |ater
in this chapter

A Hosts fle is a Ist & DNS (Domain Naming System) reources. It is sbred
on your mmputels had disk. You wse a Hostsile in oder b eaily acess
network information you wse frequery. This is the same fundion piovided
by nane severs It is reommended hat you wse nare severs raher than a
Hosts fle.

Implicit search domains

The imgdicit searty doman bakes apgar ony when he TCP/IP control panel
is set® Advanced or Alministraton wser node For instructions on seihg
the wser node see “Choasg Basic, Advanced, or Alministraton Setings’
later in this chapter

TCP/IP can aubmaitcally searb for computers gu patially identfy (in a
networking appicaton program) ly “host nand—a nane repreening that
computer onhie retwork. To male the searh posible, you spedfy a nane
representng a bcal network doman (the “stating nan®’) and a nare
represening a higer doman containing the local doman (the “ending
nan¥’). TCP/IP uses the domai nanes you entera searh for a \alid host
name when you idenify only pat of the nane

For more informaion about domai nanes and hav the searh process
works, see “Name Srvers Doman Names, and Domain Searding” later n
this thapter
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Additional search domains

TCP/IP can searh for computersm any domans you spedfy. You spedfy the
domans you want o searhb in the Additional Ssardr Domans bx. Press the
Retum key after eab doman nane you type You @n list & maly searb
domains & you want as long & your list daesrit total nore han 25 letters
and ymbds.

For more informaion about domai names and hav the searh process
works, see “Name Srvers Domain Names, and Domain Searding” later n
this thapter

Configuring TCP/IP for use with a MaclP server

To configure TCP/IP for use with a MaclP sever, follow these steps:

If necessary, click Select Zone to choose the zone of the MaclP  server you want to use.

In the box that appears, choose the zone you want.

Select MaclP Server Zone

O Current AppleTalk Z"“e: |__Click Current Zone if your MaclIP server is
‘?f"":_':‘_"j“ zone: - in the same zone as your computer. Click
Data processing Selected Zone to choose a different zone.

Internet access

Landscaping

Lunar Tanding

Manufacturing 1

Manufacturing 2

Marketing

Operationz

Quality Aszsurance

Research zone 4

—{1Show only zones with MaclP servers

7 [cancel | [ ok ]

Click OK to close the MaclP  zone dialog box.

Your TCP/IP configuraion informaion is obtaned from the MaclP sewer
when you attemptd open a etwworking conredion (for examge, by opening
a retworking appicaton program)



Working with TCP/IP configurations

A “TCP/IP configuraion’ is a vay of referring to the wllection d setings
you male in the TCP/IP control panel. The setings curenty disdayed in the
control panel are knavn as te adive onfiguraion.

You @n save different goups @ setings (onfiguraions) and svitch between
them & deired. D work with mdtiple configuraions do his:

= Make sure the TCP/IP control panel is open, and choose Configurations from the File
menu.

The Qnfiguraions wndow opens

Configurations

Active configuration: Default
fpipis..
<
4] [ cancel ] || Make Active ||

Choosing a configuration

If you seehe configuraion you want in the list, dick it, then dick Make
Active

Making a new configuration

You male a rew configuraion by stating with an existing ore and nodifying
it. To create aew configuraion, follow these steps:

In the configuration list, click to select the configuration you want to modify.

Click Duplicate.

Setting Up and Using the TCP/IP Control Panel
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In the window that appears, type a name for the new configuration, then click OK.
The rew configuraion nane apgars n the list.

Click the new configuration name, then click Make Active.

The Qnfiguraions wndowv doses

Make any changes you want to the control panel settings.

Click the close box to close the control panel (or choose Quit from the File menu).

A box appears aing if you want to save the dianges you maded the
configuration.

Click Save.

The new configuraion is svved with the changes you madeThe rext time
you open he TCP/IP control panel, your new configuraion will still be
in efed.

Saving a configuration as a file

You @n sve (export) a onfiguraion & a fle separate dtm the TCP/IP
control panel. You @an use (impot) the file to aubmatcally duplicate he
control panel setings on aother mmputer ging Open Tanspot. To sve a
configuraion & a fle, follow these steps:

In the Configurations window, click to select the configuration you want to save as a file.
Click Export.

In the box that appears, type a name for the configuration file, and choose the folder or
disk where you want to save it.

Click Save.

Your @mnfiguraion is sved & a fle in the location you chose wih the nane
you spedfied.



Opening and using a saved configuration

You @n open and wse (impot) a onfiguraion file that ha been eported
from the TCP/IP mntrol panel. To open and wse a onfiguraion file, follow
these steps:

1  Inthe Configurations window, click Import.
2 Inthe box that appears, click to select the configuration file you want to use.
3 Click Import.

The @nfiguraion is impoted into the Gonfiguraions window.
4 Click Make Active.

The setitngs spedfied in the impoted onfiguraion tale dfed immediatdy.

Choosing Basic, Advanced, or Administrative settings

When you first open he TCP/IP control panel, you see oy the besic
setings Basic setings piovide he mntrols you reed h most @ses. To see or
change oher setitngs, you must dhange the wser node flom Basic to
Advanced or Alministraton. You use Administraion node b lock settngs ©
that oher wsers annot diange them in Basic or Advanced node You Gan
further pioted locked setings by settng a pasword to limit access ©
Administraton node

IMPORTANT The Advanced ad Administraton nodes indude sefings that
can cawse retwork problems if used impopety. If you are not@re hav to use
Advanced or Alministraion node leave the setitngs undianged unil you
chedk with your network admiistraor.
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To dhoose a ser node follow these steps:
With the TCP/IP control panel open, choose User Mode from the Edit menu.

In the dialog box that appears, choose the mode you want, then click OK.

User Mode
Select user mode:
{1 Basic
@ Advanced
» Administration el Passwnrd.a.
4] (cancel | [ ok ]

If you dhoose Alministraton mode and it ha been poteded ty a pasword,
a bo appears h which you enterthe Administraton pasword.

The man oontrol panel window changes © the node yu cdose For more
informaion about @ng Administraion node see he rext sedion, “Using
Administraton Mod¢

Using Administration mode

If you dhoose Alministraton node you @n lock and unbck settngs, and set
a pasword limiting acess b Administraton node To set a pssword, foll ow
these steps:

With the TCP/IP control panel open, choose User Mode from the Edit menu.

In the window that appears, click the Administration button to select it.

Click Set Password.

In the box that appears, type the password you want to use.

When you type the pasword, you see dotss] instead bthe letters gu type
Type the password again to make sure you typed it correctly, then click OK.

If you change the wser node b Basic or Advanced, yu must wse he
password to change the node ladk to Administraton.



Locking settings

To lock settngs, set he TCP/IP control panel to Administration mode then
click the lock icon rext to ead seting you want to lock. Click again to unlbck
a seting. When you change the wser node b Basic or Advanced, he setings
you lock cannot ke dhanged.

fN==— T1CP/IP
Connect wia: Serial built-in hd |@ . . i
— Setup This setting is locked. To
@ unlock it, click this button.
Irplicit Search Path:
St:rting dornain nanne : @
IF Address: || |E | |
Subnet mask: | |E Ending dornain narme : @
Router address: E
s [} This _setti_ng islunlocked. To
Marne setver addr.: E |0Ck |t, C|ICk thIS bUttOﬂ
@

Getting information about your settings

For detailed mformaion abouthe TCP/IP addreses and ftware \ersons
currenty in dfed, do his:

m Choose Get Info from the File menu.

If the wntrol pand is in Advanced or Aiministraton node you @n ako
click the Info buton.

The TCP/IP Info window opens You @n see mformaion in this window, but
you @nnot dange it.
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Turning TCP/IP on and off

When you are not sing a TCP/IP retwork, you @n tum TCP/IP df to sve
RAM in your mmputer When you reed 6 use TCP/IP ajain, you @n tum it
on. You @n ako choose ® have TCP/IP loaded nto RAM all the time, or ony
when reeded (te reommended seithg). To tum TCP/IP on ad df, follow
these steps:

1  Make sure the user mode is set to Advanced or Administration.

For instructions on banging the wser node see “Chodsyg Basic, Advanced,
or Administratve Setiings” ealtlier in this chapter

2 Click Options.

3 Inthe dialog box that appears, choose the settings you want, then click OK.

TCP/IP Dptions

Make TCP/IP:

@ Active [ Load only when needed

) Inactive

4] [cancel | [ ok |

TCP/IP beames adive or hadive immediatdy.

About TCP/IP settings
This setion describes the setitngs available in the TCP/IP control panel, and
explains hav TCP/IP uses the informaion you enter
IP address

An IP (Intemet Potocol) address is a set bfour numiers flom 0 b 25,
separatedypdots (br exkampe, 111.123222.213). It identfies your mmputels
conredion © the retwork. You must hae an IP address b use TCP/IR
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The numlers n an IP addres are lke a téephore numter; the numters on
the Idft, like an area ode represent he “network numker” which is shared
by all the mmputers on gur network (or te pat of your retwork your
computer $ mnreded D). The numlers on e right repreent he “host
numter’ The potions d an IP addres tat repreent he retwork numier
and te host number degnd on hw that retwork is designed.

The retwork numtlers sed n IP addreses are $sued ly an auhorized
ageng to ensire hat no diplicate addrsses are sed. An oganization
assigned a rtwork numker an use all ¢ the available host numbrs hat @n
be asociated wih that retwork numtler.

Subnet mask

Some oganizations reed nore IP addreses than are gailabe with a sngle
network numter. More IP addreses an be uised wih a $ngle network
numter by dividing a retwork into setions alled sibnetworks, or sibrets A
subret mak is a set bnumbers wed n conundion with an IP addres ©
identfy a pottion d the IP address & belonging to a paticular sibnetwork.
Like an IP addrss, a sibnet mak is a set bfour numiers fom 0 b 25,
separatedypdots (br exkampe, 25251280).

If you dort enter a sbnet mak, the TCP/IP wntrol pand will provide a
defadt subret mak for you. However, the ddaut subnet mak may not ke the
best ore posible.

Router address

A router addrss is the IP addres for a outer—a deice hat dreds
informaion abng the nost dficient or appopriate retwork pahs It conreds
two networks that hae different retwork numtlers and it contains a Ist
identfyi ng the addreses d the cmmputersm eat network (and oher routers
providing conredions b different retwork numbers) When a paket o
informaion reabes the router the mouter tiedks the addres on he paket
and sends itd the pat of the retwork containing that addrss.

Setting Up and Using the TCP/IP Control Panel
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Routers hee teir own IP addresses. The IP addres d the router keing used
by your omputer $ wsed ly TCP/IP to send mformaion  the correa
network and host. Wien you wse a BotP or DHCPsewer o configure
TCP/IR the router addrss is wually provided aubmatcally. When you wse
MaclR, the router addrss is piovided auvmatcally and ma change
aubmatcally, based on a numdr d fadors talen into acount by your
computels oftware

If you hae a dalup onredion b the Intemet lsing SIP (Serial Line
Intemet Piotocol) or PPP (Roint-to-Foint Protocol) software you do not eed
to enter aouter addrss in the TCP/IP control panel.

Name servers, domain names, and domain searching

The doman nane ystem (INS) is a stadad for providing a nane
identfyi ng any computer onneded b the Intemet, and for associatng the
name with the omputeis IP address The DNS abko provides a vay to
identfy some kinds d network sewices (s1ch as dectronic mail rdays)
availabe on paticuar mmputersA computeis DNS nane (or ‘host nand’)
congsts d a numter d words or letters separateg Hots (br exame,
“mailsenerwest.xyzcorp.com.uk”). Reading right-o-left, it can indicate he
geagrapht location d the omputer (‘Uk,” or United Kingdom) an
organization type (“‘com,” or commerdal omganization), the nane d the
organization (“xyzoorp”), and the spedfic computer (he mail sever for the
westem region).

In the TCP/IP control panel, the following setings are sed wih the domain
name gstem

Name server address

A name sever (or doman nane sever) is a omputer hat trandates domain
names into IP addresses. If you enter o or nore nane sever addreses in
TCP/IP, you @n use host naes raher than IP addreses in your networking
software appcatons For exkamge, you could identfy a host omputer a

“i nfoserer.xyzoorp.cont rather than renemkering its IP address

You @n type nore han ore nane sever addrss in the nane sever addres
bax. Press Retum dter eab addres You @n list & mayy namne severs &
you want as long as your list deesrit total nore han 25 letters ad ymbds



Hosts file

The Sed Hosts He butibn apars onf when he TCP/IP control panel is
set b Advanced or Alministraton wser node For instructions on sethg the
user node see “Choasig Basic, Advanced, or Alministraton Setings,
ealtier in this dhapter

A Hosts fle is a Ist f DNS (doman namhg s/stem) reources. It is sbred
on your mmputeis had disk, usually in the Préerencs folder ingde your
adive §stem felder You wse a Hostsile in order b ealy access retwork
informaion you wse frequeny. This is the same fundion povided ly nane
sewers It is reommended hat you uise name severs raher than a Hostsife.
For informaion abouthe format or a Hostsife, see he Appendix

Domain name searching

TCP/IP can aubmaitcally searb for computers gu patially identfy (in a
networking appicaton program) ly host nam. The piocess d searting for
a host nam is @lled “resolving” the nane TCP/IP wses the stating and
endng doman nanes you enterad attempta resolve a host namwithin your
domah. TCP/IP wses the domans you enter m the Additional Sard
Domans bx to attemptad resolve a host namin different domais You @n
list & many addifonal searec domans & you want as long as your list
doesrit total nore han 25 letters ad ymbds.

Implicit searting apgends he stating and endhng doman nanes you
spedfy to a patial host nara you enter

The stating doman is dten e nane d your ovn local network doman. For
exampe, if your omputer $ naned “workstaton.mktng.east.xyzoorp.com,” you
might enter “mkng.east.xyzcorp.cont in the stating doman box.

The endng nane is the nane d the larger doman contaning the stating
name It must matt the end dthe local doman. For examge, if your
stating doman is “mktng.east.xyzcorp.com,” you ould enter Xyzoorp.cont
in the endng doman nane b.

The nanes you type in the o bokes ddine a range d domain nanes When
you wse a pdral host narg, TCP/IP tries © resolve the nane by appending
eat posible aiffix in the range
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For examge, if you hae “mktng.east.xyzoorp.coni in the first b,
“xyzcorp.cont’ in the seond b, and searh for “www,” TCP/IP tries ©
resolve these narss:

www.mktng.east.xyzcorp.com
WwWw.east.xyzcorp.com

WWW.XyZCorp.com

The nanes you type in the Additional $ard Domains bx are sed a you
type them, and are not sed b searh a range d doman narres.

” u

For examge, if the b contains “apgde.com,” “ universty.edu; and
“nowhereoryg’ and you searh for “www,” TCP/IP tries © resolve these
nanes:

www.apple.com
www.university.edu

www.nowhere.org

When trying to resolve a host nam TCP/IP sibmits eab nane b ead
sewner on yur list (in the oder hey appear n the list). This piocess
continues untl a valid nane is found, unil all comhinaions hae been tried,
or unil a nane sever repots that he host nam daes not gist.

An improperly admnistered nam sever mg incorredly repot that a host
name dces not &ist. Beauwse sich a repot siops he searh before he rext
name sever in your list is queried, it$ impotant to male sire hat he nane
sewers n your list are n the pioper oder More rdiade and ompete nane
sewers shold be at he bp d the list.



Troubleshooting

This chapter hdudes suggestions br what b try if you run into problems
using the AppleTalk or TCP/IP control panels.

If youre haing a ppblem and @rit find an answer here or ésewhere n this
manual (or in Madntosh Guide availade in the Guide [@] menu if yodre
using s/stem sftware \erson 753 or later) see lhe sevice and uppott
informaion that ame with your omputer ér informaion about ontading
Apple for additonal Felp.

AppleTalk troubleshooting suggestions
| can't turn AppleTalk on.

Make sure you tum on AppleTalk in the AppleTalk control panel. If youre
aure its tumed on n the ntrol panel, ched to male sure AppleTalk is ako
turned on n the Chooserlf you hae oter oftware hat @n tum AppleTalk
on or df, male sure its tumed on n that ®ftware & well.

| can't see any network devices in the Chooser.
Make sure your retworking calles are popefy conneded.
Make sure AppleTalk is tumed on

If AppleTalk is tumed on, mak dire yYou hae dhosen e rred pott in the
“Conred vid pop-up nenu n the AppleTalk control panel.
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If your rework numker or node numér ha been setd “User Déined; turn
off the User Ddined setitng, then dose ad reon he AppleTalk control
panel.

Make sure your retwork is fundioning corredly (contad your network
admnistrabr).

| can'’t switch from a serial to an Ethernet connection.

If you ise an expandon ard to conned to Ethermet, male sire he ad is
installed orredly.

Make sure your Bhemet alles are onneded popety.
Make sure your retwork is fundioning corredly.
| can't remember my Administration password.

You @n erae your Administraton pasword (albng with all d your
AppleTalk settngs and wnfiguraions)by dragging the AppleTalk Preferencs
file (indde te Préerences folder in your adive S/stem elder) b the Trash
When you open te AppleTalk control panel again, you must reenter all gur
settngs

TCP/IP troubleshooting suggestions

Chapter 5

| can't connect to devices outside my local network.
Make sure your muter addrss is @rred.
Make sure your sibret mak is rred.

| can connect to hosts by P address, but not by name.

Make sure you hae entered at lsh ore nane sewver addres, and that he
addres is wrred. If you hae entered mre han ore, male sure he nost
reliade ores are Isted frst.

Make sire you hae entered alid doman nanes in the Additional Sard
Domans bo.



For each item you
want to remove,
click its box to put
an Xin it.

If you hae entered stting and endihg doman nanes for an imglicit seard,
doube-ched to male sure hey're wrred. (The local and admiistratve
doman nanes @n be entered oglwhen he TCP/IP control panel is set®
Advanced or Aiministraton user node)

My computer does not respond to a “ping.”

Make sure you hae an adive apflicaion on yur cmputer hat wses TCP/IP
and @n respond © a “ang” from another omputer

Make sure your TCP/IP configuraion is crred.

Make sure your retwork cades are popedy conneded.
Make sure your retwork is fundioning propetly.

| can't remember my Administration password.

You @n erae yur Administraton paswvord (albong with all o your TCP/IP
settngs) by dragging the TCP/IP Prderencs file (indde te Prdéerencs
folder in your adive §stem elder) b the Trash When you open he TCP/IP
control panel again, you must reenter all gur setings.

=————— O0Open Transport Installation E&=F"Fic——-"oP12
[ Custom Remove |
Check features to be removed
b ] Open Transport (68K Only) [ )5ty
v&D Open Transport [E]
[J Apple Shared Library Manager for 68k Macintoshes [Ex]
[ Apple Shared Library Manager for PowerPC Macintoshes ]
[+ [ AppleTalk support for Open Transport [E]
[ [ TCP/IP support for Open Transport [Ex] . .
O Menu Manager Update o Click the letter ito
k84 see information
Disk space available: 137,564k Selected size: zero K .
...... Pestination Disk about each item.
Fient Hisk
[
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Appendix
TCP/IP Hosts File Format

A Hosts fle is a Ist & DNS (Domain Naming System) reources. It is sbred
on your mmputeis had disk, usually in the Préerencs folder ingde your
adive Sstem Blder, and @n be wsed ly the TCP/IP control panel. The
informaion in a Hostsife congsts d a seris d records hat must be in the
following format:

domain name data ;comment (optional)

Domain nanes mwst @ontan at leat ore dot n order b be wsed n a Hosts
file. For exkampe: “apgde.cont is an allowale nane; “apge’ is not.

The datam a Hostsife recrd indude he following informaion, eab
separatedypone or nore spaceltaraters Comments mst be precededyb
a semcolon.

Information Notes

ttl (time to live): the record’s configured lifetime in seconds. This is optional. If it is not
present, or if it is “-1”, the entry is assumed to have an infinite lifetime.

class (optional): the only class currently supported is IN (Internet domain)

type (required): use “A” for host address, “CNAME” for canonical name of an alias, or “NS”

for name server

IP address

ecccoe
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Examges d valid Hosts ile recmrds are:

apple.com A 130.43.2.2 ; address of host apple.com
foobar CNAME barfoo.apple.com ; canonical name for the host whose local alias is “foobar”
xyzcorp.com 86400 NS biglist.xyzcorp.com ; name server for xyz corp.—entry has a 1-week life

To use a MacTCP Hostsife with TCP/IP male aure all d the listed domai
names ontan at leat ore dot. MacTCP albws the Hosts ile to contan
doman nares that ontan no dotsin TCP/IR such a nane will cause a
error unless it is an alias

To use a domai nane with no dotsm the TCP/IP Hosts fle, you @an use o
records The first reord associates a bcal alias with a \alid nang, and the
seond resolves the doman nane © an IP addres For examge, you might
have the following entry n a MacTCP Hostsife:

bigcomputer A 128.1.1.1
To acomgish he same dfed of associating “bigcomputer” wih the addres
128111 a TCP/IP Hosts fle needs lhese two remrds:

bigcomputer CNAME largedomain.xyzcorp.com
largedomain.xyzcorp.com A 128.1.1.1

The first reord associates the alies “bigcomputer” wih the valid doman
name “lagedoman.xyzoorp.com” The seond reord resolves that doman
name o the IP address 228111
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Macintosh Guide (Guid® menu)| 3
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manual connection 29-32
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server connection 32
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0
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printer port, connecting to AppleTalk
network | 13
protocols
AppleTalk |11
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